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Preface

The GNOME 2.0 Desktop for the Solaris Operating Environment Troubleshooting Guide
describes known problems with the GNOME 2.0 Desktop for the Solaris™ 8 operating
environment and the Solaris 9 operating environment. The guide provides
workarounds for many of the known problems.

Who Should Use This Book

Different chapters in this manual provide information for the following users:

Accessibility engineers and users with accessibility needs
Developers

End users

Localization teams

System Administrators

How This Book Is Organized

This guide is structured in the following way:

m  Chapter 1 discusses problems and workarounds that system administrators and
users might encounter when installing the desktop environment.

m  Chapter 2 discusses problems that system administrators and users might
encounter when they start up the desktop environment for the first time.

m  Chapter 3 provides information for users about how to deal with window and
session management problems in the desktop environment.



m  Chapter 4 provides information about general problems that users might have with
the desktop environment.

m  Chapter 5 provides information about problems that users might have with
GNOME applications.

m  Chapter 6 provides information about hardware problems that might affect your
desktop environment.

m  Chapter 7 provides some tips for users about improving the performance of the
desktop environment.

m  Chapter 8 provides information about how to deal with accessibility-related
problems in the desktop environment.

®  Chapter 9 provides information for localization teams about how to deal with
localization-related problems in the desktop environment.

Related Books

The following manuals are related to this guide.

®  GNOME 2.0 Desktop for the Solaris Operating Environment Accessibility Guide
m  GNOME 2.0 Desktop for the Solaris Operating Environment Installation Guide
®m  GNOME 2.0 Desktop for the Solaris Operating Environment Release Notes

®m  GNOME 2.0 Desktop for the Solaris Operating Environment System Administration
Guide

m  GNOME 2.0 Desktop for the Solaris Operating Environment User Guide

Accessing Sun Documentation Online

The docs.sun.com®™ Web site enables you to access Sun technical documentation
online. You can browse the docs.sun.com archive or search for a specific book title or
subject. The URL is http://docs.sun.com.
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Ordering Sun Documentation

Sun Microsystems offers select product documentation in print. For a list of
documents and how to order them, see “Buy printed documentation” at
http://docs.sun.com.

Typographic Conventions

The following table describes the typographic changes that are used in this book.

TABLE P-1 Typographic Conventions

Typeface or Symbol | Meaning Example
AaBbCcl123 The names of commands, files, and Edit your . login file.
directories, and onscreen computer . .
P Use 1s -a to list all files.
output
machine name% you have
mail.
AaBbCcl23 What you type, contrasted with onscreen | machine name$% su
computer output
Password:
AaBbCc123 Command-line placeholder: replace with | To delete a file, type rm
a real name or value filename.
AaBbCc123 Book titles, new terms, or terms to be Read Chapter 6 in User’s Guide.

hasized
emphasize These are called class options.

You must be root to do this.

Shell Prompts in Command Examples

The following table shows the default system prompt and superuser prompt for the C
shell, Bourne shell, and Korn shell.


http://docs.sun.com

TABLE P-2 Shell Prompts

Shell Prompt

C shell prompt machine_name%
C shell superuser prompt machine name#
Bourne shell and Korn shell prompt $

Bourne shell and Korn shell superuser prompt | #
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CHAPTER 1

Installation Problems

This section provides tips about dealing with problems that arise when you install the
GNOME 2.0 Desktop on the Solaris™ 8 operating environment or Solaris 9 operating
environment.

“1.1 Installation Log” on page 11

“1.2 Installation Failed Error Message” on page 12

1.3 Uninstalling the GNOME 1.4 Desktop” on page 12

“1.4 Uninstalling the GNOME 2.0 Desktop” on page 12

“1.5 Installing the GNOME Desktop Without the Installer” on page 13
1.6 ScrollKeeper Fails After Installation” on page 13

1.1 Installation Log

Problem Where do I look for installation errors?

Solution The most recent GNOME 2.0 Desktop installation log is in the
following location: /var/sadm/install/logs

1



1.2 Installation Failed Error Message

Problem The installation fails with the following error message: pkgadd:
ERROR: cppath(): unable to start
Solution You are either using the wrong version of tar or the tar file is

corrupt. You must use Solaris tar or GNU tar version 1.13 or
greater. If the tar file is corrupt, you must download the tar file
again.

1.3 Uninstalling the GNOME 1.4
Desktop

Problem I already have the GNOME 1.4 Desktop on system. How do I
uninstall the GNOME 1.4 Desktop?

Solution Perform the following steps:
1. Log into CDE as root.
2. Open a terminal window.
3. Type cd /var/sadm/prod
4. Type java uninstall_gnome_1_4

If you have already installed the GNOME 2.0 Desktop, you can
remove the GNOME 1.4 Desktop by logging in as root and running
the following command: /usr/sbin/remove-gnome -version
1.4

1.4 Uninstalling the GNOME 2.0
Desktop

Problem How do I uninstall the GNOME 2.0 Desktop?
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Solution Perform the following steps:
1. Log in as root.
2. Run the following command: /usr/sbin/remove-gnome

1.5 Installing the GNOME Desktop
Without the Installer

Problem How do I install the GNOME 2.0 Desktop without the GUI
installer?
Solution Run the alternative text-based install script. To do this you must

first unpack the tar file to create a GNOME directory in your
current directory. Then run the script which corresponds to your
system architecture:

SPARC Architecture Edition: . /GNOME/sparc/pkgs/install

x86: Architecture Edition: . /GNOME/1386/pkgs/install

1.6 ScrollKeeper Fails After Installation

Problem ScrollKeeper fails after Jumpstarts, upgrades and live upgrades.

Chapter 1 ¢ Installation Problems 13
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Solution

ScrollKeeper fails due to software dependencies not being available.
The workaround is as follows:

For all installations, upgrades and live upgrades that install directly
into the root filesystem, the ScrollKeeper database is propagated
during the installation, using a postinstall script provided with each
package as required.

For all other installations that do not install into the root filesystem
directory, the postinstall script does not propagate the ScrollKeeper
database.

You must propagate the ScrollKeeper database manually when you
log in for the first time. You need root access to perform this action.
Execute the following commands in the C locale:

1. su password

2. /usr/bin/scrollkeeper-rebuilddb

In some cases, the location of /usr/bin/scrollkeeper-
rebuilddb might be similar to the following:
{INSTALL ROOT}/usr/bin/scrollkeeper-rebuilddb

GNOME 2.0 Desktop for the Solaris Operating Environment Troubleshooting Guide ¢ April 2004



CHAPTER 2

Startup Problems

This section describes issues that might occur when you start up the GNOME 2.0
Desktop.

m  “2.1 GNOME Desktop Menu Item Missing From Login Screen” on page 15
m  “2.2 Startup Error Messages” on page 16
m  “2.3 General Startup Problems” on page 16

2.1 GNOME Desktop Menu Item
Missing From Login Screen

Problem A menu item for the GNOME 2.0 Desktop does not appear in the
login screen.

Solution GNOME dtlogin resource files are currently only installed for the C
locale. To make the GNOME login option appear in other locales,
you must copy this resource file to the correct directory for your
locale. Use the following command to copy the dtlogin file:

cp /usr/dt/config/C/Xresources.d/Xresources.Sun-
gnome-2.0* /usr/dt/config/{your
locale}/Xresources.d Future releases will include localized
versions of this file.

15



2.2 Startup Error Messages

Problem Where do I look for error messages if startup fails?

Solution The following files contain messages that might be helpful in
diagnosing incorrect permissions, missing files and other
problems.

~/.dt/startlog
~/.dt/startlog.old
~/.dt/startlog.older

To enable logging of more detailed information, edit
~/.dtprofile and remove the
dtstart sessionlogfile=/dev/null line.

The session logs are placed in the following location:
~/.dt/sessionlogs/*

An alternative solution is to run gnome-session from a failsafe
session, and read any error messages that appear.

2.3 General Startup Problems

Problem How do I fix general startup problems such as the following:
B The login process never gets past the black screen.

B Panels do not respond to my input.

®  Jcons do not display correctly.

®  Panels do not appear.

®  Error messages appear referring to missing files in
/opt/gnome-2.0/share.

m

The GNOME Menu icon appears in place of the correct icon.
B The desktop background image is an empty white space.
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Solution Perform the following steps:

1. Run the following cleanup script: /usr/bin/gnome-cleanup

2. Remove your session files from ~/.dt/sessions/gnome

3. Make sure you do not have anything in your .xinitrc file that
conflicts with the GNOME 2.0 Desktop. If you are not sure,
rename your ~/ .xinitrc fileto /.xinitrc.orig and try to
login again.

4. Make sure your LD_LIBRARY_PATH does not point to a
directory which contains incompatible versions of the GNOME
libraries. The GNOME 2.0 Desktop does not require
LD_LIBRARY_PATH to be set at all. If you must define this for
other applications, try adding /usr/1ib and /usr/sfw to the
beginning of your LD_LIBRARY_PATH.

5. Kill the gconfd-2 process.

6. Run the following command: bonobo-slay
Try to log in again.

Chapter 2 » Startup Problems 17
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CHAPTER 3

Window and Session Management
Problems

This section provides information about how to deal with window and session
management problems in the GNOME 2.0 Desktop.

“3.1 Window Manager Crashes” on page 19

“3.2 Logging Out Without a Panel” on page 19

“3.3 Applications Do Not Restore Properly” on page 20
3.4 Unexpected Window Behavior” on page 20

“3.5 Unexpected Swing Behavior” on page 21

3.1 Window Manager Crashes

Problem The Metacity window manager crashes, and the frames disappear
from all windows.

Solution Session manager automatically restarts the window manager. If this
does not happen, log out and then log back in.

3.2 Logging Out Without a Panel

Problem How do I 'log out if all my panels have disappeared?

19



Solution 1. Right-click on the desktop background to open the desktop
background menu.
2. Select the menu item New Terminal.
3. Enter the following command in the new terminal:
gnome-session-save --kill
4. If you still cannot log out, then run the following command:
pkill gnome-session

3.3 Applications Do Not Restore
Properly

Problem When I logged out, I selected Save current setup, but some
applications did not restore properly the next time I logged in.

Solution The following applications have the following known problems:
B Terminal does not restore.
®  Gedit restores to the upper left corner of the screen.

There are plans to fix these problems in a future release.

3.4 Unexpected Window Behavior

Problem Some of my application windows appear above all desktop
environment windows and do not restore properly or appear in the
GNOME window list.

Solution By default, many applications which are based on MainSoft

libraries ignore the window manager and attempt to manage their
own windows. Rational Rose and XML Professional Publisher are
known to have this problem. To tell MainSoft-based applications to
behave correctly, you must set the MWWM environment variable as
follows:

MWWM=allwm
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3.5 Unexpected Swing Behavior

Problem Swing components prior to those included in Java™ 2 Platform
Standard Edition V1.4 do not position, resize, or refresh consistently

Solution Perform the following steps:
1. Upgrade to Java 2 Platform Standard Edition V1.4 or later.
2. Ensure that your application is configured to use the Java 1.4
JVM.

Chapter 3 » Window and Session Management Problems 21
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CHAPTER 4

General GNOME Desktop Problems

This section provides information about how to deal with general problems in the
GNOME 2.0 Desktop.

“4.1 Finding Out More” on page 23

“4.2 Which Version of the GNOME Desktop?” on page 24
“4.3 Displaying Developer Documentation in Netscape 4.x” on page 24
“4.4 General Error Messages” on page 25

“4.5 No Nautilus Viewer for File Type” on page 25

“4.6 Nautilus Crashes Or Freezes” on page 26

“4.7 Nautilus Slows the System” on page 26

“4.8 TIF Files Crash Panels” on page 26

“4.9 Finding Out About GConf” on page 27

“4.10 Conflicts With Screensavers” on page 27

“4.11 Selected Screen Does Not Display” on page 28

“4.12 Solaris Removable Media Manager” on page 28

4.1 Finding Out More

Problem I am having a problem with the GNOME 2.0 Desktop. Where can I
find more information?
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Solution You can find more information about the GNOME Desktop in the
following places:

B Open the Applications menu, then select Help.

B Browse the GNOME 2.0 Desktop for the Solaris Operating
Environment User Guide. You can find the most recent version of
this manual on the following website: http://docs.sun.com

®  The following websites also have useful information about the
GNOME project:

B http://www.gnome.org
B http://mail.gnome.org
B http:/ /bugzilla.gnome.org

4.2 Which Version of the GNOME
Desktop?

Problem How do I find which version of the GNOME Desktop is running?
Solution Right click on a panel and select About GNOME.

4.3 Displaying Developer
Documentation in Netscape 4.x

Problem Developer documentation located in /usr/share/gnome/devel -
doc does not display correctly in Netscape 4.x

Solution gtk-doc makes use of cascading stylesheets (CSS) which are not
completely supported in Netscape 4.x. The following browsers
support CSS fully:
®  Netscape 6.x, and higher versions of Netscape
®  Opera
®m  Galeon
B Mozilla
B Internet Explorer 5, and higher versions of Internet Explorer
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4.4 General Error Messages

Problem

Solution

Where do I look for error messages when an application crashes or
fails to run correctly?

Look in the following files:
m  ~/.dt/errorlog
~/.dt/errorlog.old
~/.dt/errorlog.older
~/.dt/sessionlogs

You can also try running the application from a command line to
see if any error message appear.

You can capture a core file from a GNOME-compliant application
by running the application with the --disable-crash-dialog
option or by setting the GNOME_DISABLE CRASH_DIALOG
environment variable to 1 before running the application.

4.5 No Nautilus Viewer for File Type

Problem

Solution

When I double-click on some file types in Nautilus, a dialog
indicates that Nautilus has no installed viewer capable of
displaying the file.

Perform the following steps:

1. Open the Applications menu.

2. Choose Desktop Preferences -> Advanced -> File Types and
Programs.

3. Make sure the MIME type or extension for the file is associated
with an application in the File Types and Programs dialog.

4. Make sure that the associated application is in your $PATH.

Chapter 4 » General GNOME Desktop Problems 25



4.6 Nautilus Crashes Or Freezes

Problem Nautilus crashes or freezes when an open browser window points
to a bad NFS mount.
Solution Run the following command: pkill nautilus

When Nautilus restarts, the bad NFS directory is not available. If
you saved a session while Nautilus was pointing to a bad mount,
remove your session files in ~/.dt /sessions/gnome.

4.7 Nautilus Slows the System

Problem Nautilus slows my system or freezes when searching for Trash on
an NFS mounted volume.

Solution Perform the following actions to prevent Nautilus from searching
for trash on a NFS file systems:

1. Edit the following file:
/usr/share/gnome/nautilus/filesystem-
attributes.xml

2. Set the following entry:
filesystem name="nfs" default volume name="NFS
Network Volume" trash="no"

3. Run the following command to restart Nautilus: pkill
nautilus

4.8 TIF Files Crash Panels

Problem My panels crash when I select a TIF image file in the panel
properties background dialog.
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Solution

To resolve this problem you must ensure that /usr/sfw/1ib
precedes /usr/openwin/lib in your LD_LIBRARY PATH.

4.9 Finding Out About GContf

Problem

Solution

How do I find out about the GNOME 2.0 Configuration System
(GConf)?

You can find more information about GCconf at the following
website: http:/ /www.gnome.org/projects/gconf

The GNOME 2.0 Desktop for the Solaris Operating Environment
System Administration Guide also has a chapter that describes
GConf functionality.

4.10 Conflicts With Screensavers

Problem

Solution

My screen lock preferences contain the following screensaver
displays that can conflict with some frame buffer drivers:

B Insecure screen distortion screensaver displays

B Screensaver displays such as julia and penrose

These screensaver displays occasionally run when I select random
screensaver.

You have an old ~/ . xscreensaver file. Perform the following
steps:

1. Remove the ~/.xscreensaver file.

2. Log out, then log in.

You can deselect screensaver displays that you do not need in the
Display Modes tab of the screensaver properties dialog.

Chapter 4 » General GNOME Desktop Problems 27
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4.11 Selected Screen Does Not Display

Problem

Solution

28

I can configure the screensaver displays in the configuration panel,
but when I preview the screensaver display, or specify a blank
screen, my chosen screensaver display does not appear.

XScreenSaver only enables graphical screensaver displays on
machines that are running DPMS (Display Power Management
System). You can enable DPMS with the following command:
xset +dpms

Sun Ray™ clients do not run DPMS.

4.12 Solaris Removable Media Manager

Problem

Solution

Which operating environment do I need to install the Solaris
Removable Media Manager?

Nautilus provides functionality similar to the Solaris Removable
Media Manager. To avail of the Removable Media feature in the
GNOME Desktop, the version of the operating environment must
be Solaris 8 Update 1 or higher. Do not attempt to install this
feature by installing a set of ad hoc patches.

GNOME 2.0 Desktop for the Solaris Operating Environment Troubleshooting Guide ¢ April 2004



CHAPTER 5

Problems With Specific Applications

This section provides information about problems and associated workarounds for
specific applications.

m  “5.1 Dynamically-Set Title Does Not Work” on page 29
m  “5.2 ScrollKeeper Options Not Fully Documented” on page 31
m  “5.3 Table of Contents is Empty in Help Page” on page 32

5.1 Dynamically-Set Title Does Not Work

Problem Bug ID 4855527, Terminal.

In the Editing profile window, Title and Command tab, the menu
options for the drop-down menu Dynamically-set title do not
work. Terminal uses the following bash shell environment variable
to set the dynamically-set title and the shell prompt:

PROMPT COMMAND=$'echo -ne
"\\033]0;${USER}@3{HOSTNAME}: ${PWD}\\007"’
PS1=$’ [\\u@\\h \\W]\\$ ’ USER='id -un"

On Linux /etc/bashrc sets the required environment variables,
but does not set these variables for the Solaris operating
environment. Hence, the dynamically-set title and the shell prompt
do not work in the Solaris operating environment.

29



Solution As a workaround you can set the required environment variable by
executing scripts for the various shells.

bash shell:
Set the following in bashrec:

case $TERM in
xterm*)
PS1="\[\033]0;\u@\h: \w\007\bash\\$ "
*)
PS1="bash\\$ "

”

esac
(or)

USER='/usr/xpg4/bin/id -un’
export USER

PROMPT_COMMAND-="echo -ne "\033]0;${USER}@${HOSTNAME}: ${PWD}\007"
ksh shell:
Add the following in the ~.profile file:

myed () {
cd "${@}"; echo "\033]0;${USER}@${HOSTNAME}: ${PWD}\007\c"
}

alias cd=mycd
csh shell:
Set the following in cshrc:

switch ($TERM)
case "xterm*":
set host="hostname’
alias cd 'cd \'*; echo -n "7[]0;${user}@${host}:
${cwd}"Gesh% "
breaksw
default:
set prompt="csh% ’
breaksw
endsw

The "A[" and "AG’ characters in the prompt string are single
characters for ESC and BEL. You can enter these characters using
Ctrl+v+ESC and Ctrl+v+g.
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5.2 ScrollKeeper Options Not Fully
Documented

Problem

Solution

ScrollKeeper.

In the scrollkeeper-rebuilddb man page, the -o and -p
options are not fully documented.

You do not need to use the -o and -p options to perform a
standard setup of the ScrollKeeper database. These options are
required only in the following situations:

B The ScrollKeeper database must be installed in a location other
than the standard location. For example, setting up diskless
clients.

Use the -p path option to specify the location of the
ScrollKeeper database, where path is an empty directory. The
scrollkeeper-rebuilddb command will not proceed if you
specify a populated path for this option.

®  The OMF files must be read from a location other than the
standard location. The standard location for OMEF files is
specified in the /etc/scrollkeeper. conf file.

Use the -o path option to specify the location of the OMF files.
Specify the complete pathname, for example,
/usr/share/onf. If you specify a partial pathname, for
example, /usr/share, the scrollkeeper-rebuilddb
command will take a long time, produce many warnings, and
may crash.

The following example shows how to use the -o and -p options to
set up the ScrollKeeper database for diskless clients:

# scrollkeeper-rebuilddb \

-p /export/root/clone/Solaris 9/\
sun4u/var/gnome/lib/scrollkeeper \

-o /export/exec/Solaris 9 sparc.all/\
usr/share/omf
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5.3 Table of Contents is Empty in Help
Page

Problem Bug id 4875223.

The Table of Contents is missing from the first page in the GNOME
Help browser.

Solution This is a ScrollKeeperissue. See “1.6 ScrollKeeper Fails After
Installation” on page 13 for the workaround.
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CHAPTER 6

Hardware Problems

This section provides information about how to deal with hardware-related problems
in the GNOME 2.0 Desktop.

“6.1 Multihead Display” on page 33

“6.2 Sound Events Do Not Work” on page 34

“6.3 Configuring Your Mouse for x86 Systems” on page 34

“6.4 Running the GNOME Desktop on a Sun Ray Server” on page 36
“6.5 No Sound From Audio CD” on page 36

6.1 Multihead Display

Problem

Solution

My machine has more than one head. How do I display GNOME
applications on the second head?

The GNOME Desktop installation process can detect machines with
more than one head. Multihead displays should start automatically.
You can also manually bring up an application on an alternate head
by setting your $DISPLAY variable or launching the application
with the --display=:0.n flag, where n is the display number.

If you use two identical frame bulffers set for the same video depth,
you can also modify /etc/dt/config/Xservers or
/usr/dt/config/Xservers to run XSun in Xinerama mode. The
GNOME Desktop then treats both video heads as a single logical
display.
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6.2 Sound Events Do Not Work

Problem Sound events do not work in Nautilus.

Solution Perform the following steps:

1. Open the Applications menu.

2. Choose Desktop Preferences -> Sound.

3. Select the following options:
®  Enable sound server startup
B Sounds for events

4. Hover the mouse pointer over file icons to listen to certain
types of sound event in Nautilus.

All events are not yet enabled.

6.3 Configuring Your Mouse for x86
Systems

Problem Neither a two-button mouse, nor a three-button mouse work
correctly when the GNOME Desktop is running on the x86
architecture edition.
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Solution

Many GNOME applications require a three-button mouse. You need

to do the following:

B Three-button mouse: enable the third button.

®  Two-button mouse: emulate a third button when you click on
the two buttons simultaneously.

To enable a third mouse button, or emulate a three-button mouse,
perform the following steps:

1. Choose Options -> Command Line Login from the login screen.

2. Press Return, then log in as root.

3. Type the following command: kdmconfig
The kdmconf ig command launches the Solaris Device
Configuration Assistant, which displays the current system
configurations. The program only accepts keyboard input. Use
the keys shown in Table 6-1 to navigate through the menus.

Press F2 to open the next screen.

Select the appropriate mouse type or emulation.

Press F2 to return to the main screen. The Pointer Device
should have visibly changed.

8. Press F2 to display a test screen.

9. Click Yes if the screen display is correct.

10. Type the following command to quit the console session: Exit

N o O

The system should now be properly configured to use a
three-button mouse.

TABLE 6-1 Navigation Keys for the Solaris Device Configuration Assistant

From the main window, select Change Pointing Device/Mouse.

Key

Function

Down arrow
Up arrow
F2

F3

Return

Moves the cursor down a menu.
Moves the cursor up a menu.
Opens the next screen.

Exits the program without saving.

Selects an option.
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6.4 Running the GNOME Desktop on a
Sun Ray Server

Problem How do I run the GNOME 2.0 Desktop on a Sun Ray thin client
server?

Solution Perform the following steps:
1. Install the GNOME Desktop in the normal way.

2.

If the GNOME 2.0 option does not appear on the login screen of
the Sun Ray client, choose Options -> Reset Login Screen.

6.5 No Sound From Audio CD

Problem I do not hear any sound from my audio CD.
Solution Perform the following steps:
1. Open the Applications menu.
2. Choose CDE Menu -> Applications -> Audio Control.
3. Select the Playback tab, then turn on one of the following
devices that you want to listen to:
®  Built-in Speaker
®  Headphone
®  Line Out
4. Select the Record tab, then select Internal CD for the Master
Input.
5. Adjust the monitor volume to a non-zero value.

You can now listen to CDs with the CD Player application.

Note — This procedure might not work on all Sun hardware and CD
configurations.

36 GNOME 2.0 Desktop for the Solaris Operating Environment Troubleshooting Guide * April 2004



CHAPTER 7

Performance Enhancement

This section provides some tips on improving the performance of the GNOME 2.0
Desktop. You can find more detailed information about improving performance in the
GNOME 2.0 Desktop for the Solaris Operating Environment System Administration Guide.

“7.1 Adjust Nautilus Settings” on page 37

“7.2 Adjust Background Settings” on page 38

7.3 Change Window Frame Theme” on page 38

“7.4 Reduce Applets” on page 38

7.5 Transparent Terminals” on page 39

“7.6 Enable Wireframe Window Moves” on page 39

“7.7 Install mediaLib Libraries” on page 39

7.8 Improving CDE Application Performance” on page 40

7.1 Adjust Nautilus Settings

Tip You can improve the performance of the GNOME Desktop by
optimizing the settings of the Nautilus window manager.

Action Open a Nautilus window.
Choose Edit -> Preferences.
Select Performance.

Make sure all options are set to Local File Only or Never.

Ll IS
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7.2 Adjust Background Settings

Tip If you run the GNOME Desktop remotely over a slow network,
you can adjust the desktop background settings to improve
performance.

Action 1. Open the Applications menu.

2. Choose Desktop Preferences -> Background.
3. Click on the No Picture button.
4. Select Solid color in the Background Style drop-down list.

7.3 Change Window Frame Theme

Tip You can change your window frame theme to a more basic selection
to improve performance.

Action Open the Applications menu.
Choose Desktop Preferences -> Theme.
Click the Window Frames tab.

Select a basic theme, for example Atlanta.

LS.

7.4 Reduce Applets

Tip Reducing the number of applets in your panels can improve
performance.
Action Remove applets from your panels that you are not using.
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7.5 Transparent Terminals

Tip

Action

Using terminals with transparent backgrounds can affect the
performance of the GNOME Desktop.

If your terminals have transparent backgrounds, then perform the
following actions in a terminal:

1. Open the Edit menu.

2. Select Profiles.

3. Open the Effects tab.

4. Select the None (use solid color) option.

7.6 Enable Wireframe Window Moves

Tip

Action

You can improve performance by enabling windows to move in
wireframe mode.

Run the following command:

gconftool-2 -s

/apps/metacity/sun extensions/wireframe move resize
-t bool true

7.7 Install medialib Libraries

Tip

Action

The GNOME 2.0 Desktop includes support for the mediaLib™
libraries. Installing these libraries can noticeably improve the
performance of the GNOME Desktop.

See the mediaLib website for information on installation of this
package: http:/ /www.sun.com/processors/vis/mlib.html

Chapter 7  Performance Enhancement 39


http://www.sun.com/processors/vis/mlib.html

7.8 Improving CDE Application
Performance

Tip How do I improve the performance of CDE applications in the
GNOME 2.0 Desktop?
Action By default the following CDE programs are turned off when you

log in to a GNOME Desktop session:
B  dtdbcache
dtdbcache sets up a cache to speed up CDE programs that use
actions such as dt file. If this cache is not set up, CDE
applications that use actions run more slowly. To turn this
feature back on, you can start this program manually or by
launching the program from a startup script. Perform the
following actions:
1. Log in as root, then open the following file:
/usr/dt/config/Xsession.Sun-gnome-2.0-fcs
2. Delete the following line: export
SDT_NO_DTDBCACHE="1"
B ttsession
ttsession is the Tooltalk daemon. In CDE, this program is
always launched when the user first logs in. In the GNOME 2.0
Desktop, this daemon is started automatically by the first
program that makes use of Tooltalk. You can restore the CDE
behavior by using a startup script. Perform the following
actions:
1. Log in as root, then open the following file:
/usr/dt/config/Xsession.Sun-gnome-2.0-fcs
2. Delete the following line: export SDT NO_TOOLTALK="1"
B  dtappgather
dtappgather is a support program for the CDE Application
Manager. Normally, you do not need to run this program in a
GNOME Desktop session. However, if you want to run this
program, then you can start dtappgather manually or by
launching the program from a startup script. Perform the
following actions:
1. Log in as root, then open the following file:
/usr/dt/config/Xsession.Sun-gnome-2.0-fcs
2. Delete the following line: export
SDT_NO_APPGATHER="1"
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CHAPTER 8

Accessibility Problems

This section provides information about how to deal with accessibility-related
problems in the GNOME 2.0 Desktop.

m  “8.1 Keyboard Is Unresponsive” on page 41

“8.2 Numeric Keypad Is Unresponsive” on page 42

“8.3 System Beeps Continuously” on page 42

“8.4 System Beeps Incorrectly for Slow Keys” on page 43
“8.5 Mouse Keys Functionality” on page 43

8.1 Keyboard Is Unresponsive

Problem The keyboard stops responding when I do the following:
1. Select the Enable Mouse Keys option in AccessX.
2. Select either Enable Bounce Keys or Enable Slow Keys.
3. Use the numeric keypad to move focus to the Testing Area text
box.
4. Press 5 on the numeric keypad to click in the Testing Area text
box.

The keyboard does not work in any application, such as Terminal,
gedit, and so on.
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Solution Perform the following actions:

1.
2.
3.

Select the Enable Mouse Keys option in AccessX.

Use Mouse Keys to enable the Bounce Keys feature.

Use the numeric keypad to move focus to the Testing Area text
box.

Press 5 on the numeric keypad to click in the Testing Area text
box.

Press 5 a second time in the Testing Area text box.

Type as normal using keyboard.

Perform the same sequence of actions for Slow Keys.

8.2 Numeric Keypad Is Unresponsive

Problem The numeric keypad stops responding when I enable XKB on a
Solaris 8 or a Solaris 9 system.

Solution Use the numeric keys in the main part of the keyboard.

8.3 System Beeps Continuously

Problem This problem is displayed on Sun Ray systems only.

The system beeps continuously when I do the following:

1. Select the Enable keyboard accessibility option in the AccessX
dialog.

2. Select either of the following accessibility options:
®  Enable Toggle Keys
®  Enable Sticky Keys and Beep when modifier is pressed

3. Press a modifier key or press a toggle key.

Solution To stop the beeps, you must log out and log in again. Then, perform

the following actions in the AccessX dialog:

1. Deselect the Enable Toggle Keys option.

2. Deselect the Beep when modifier is pressed option for sticky

keys.
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8.4 System Beeps Incorrectly for Slow

Keys

Problem

Solution

The Beep when key is rejected option for Slow Keys is not working
correctly when I do the following:

Select the Enable Slow Keys option in the AccessX dialog.
Select the Beep when key is rejected option.

Deselect the Beep when key is accepted option.

Press-and-hold a key for the time specified in the Only accept
keypress after spin box.

Release the key. The system accepts the keypress but the system
beeps when you release the key.

In this situation, the system should not beep when you release the
key after a successful keypress.

Perform the following actions:

1.
2.

Deselect the Beep when key is rejected option.
Select the Beep when key is accepted option.

8.5 Mouse Keys Functionality

Problem

Solution

This problem is displayed on Sun Ray systems only.

When you enable the Mouse Keys feature, the 9 key on the numeric
keypad should move the mouse pointer upwards and diagonally to
the right. However, the 9 key moves the pointer straight upwards.

Press the 8 key to move the pointer upwards and press the 6 key to
move the pointer to the right.
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CHAPTER 9

Localization and Internationalization
Problems

This section provides information about how to deal with localization- and
internationalization-related problems in the GNOME 2.0 Desktop.

“9.1 Localized Locales” on page 45

“9.2 Problems That Affect All Locales” on page 48

“9.3 Problems That Affect European Locales” on page 50
“9.4 Problems That Affect Asian Locales” on page 54

“9.5 Problems That Affect Complex-Text Locales” on page 61

9.1 Localized Locales

Note — Arabic and Hebrew are not fully supported locales.

The GNOME 2.0 Desktop supports the locales listed in the following table.

Language Locale
Arabic ar
ar_EG.UTF-8
Brazilian Portuguese pt_BR.ISO8859-1
pt_BR.UTF-8
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Language Locale
Chinese, Simplified zh
zh.GBK
zh.UTF-8
zh_CN.EUC

Chinese, Traditional

English

French

German

zh_CN.GB18030
zh_CN.GBK
zh_CN.UTF-8
zh_HK.BIG5HK
zh_ HK.UTF-8

zh TW
zh_TW.BIG5
zh_TW.EUC
zh_TW.UTF-8
Posix (C)
en_AU.ISO8859-1
en_CA.ISO8859-1
en_GB.ISO8859-1
en_GB.ISO8859-15
en_IE.ISO8859-1
en_IE.JSO8859-15
en_NZ.ISO8859-1
en_US.ISO8859-1
en_US.ISO8859-15
en_US.UTF-8
fr_FR.ISO8859-1
fr_ FR.ISO8859-15
fr FR.UTF-8
de_DE.ISO8859-1
de_DE.ISO8859-15
de_DE.UTE-8
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Language

Locale

Hebrew

Italian

Japanese

Korean

Polish

Russian

Spanish

Swedish

he

he_IL.UTF-8
it_IT.ISO8859-1
it_IT.ISO8859-15
it ITUTF-8

ja

ja_JP.euc]P
ja_JP.PCK
ja_JP.UTF-8

ko

ko_KR.EUC
ko.UTF-8
ko_KR.UTF-8
pl_PL.ISO8859-2
pl_.PL.UTF-8
ru_RU.ANSI1251
ru_RU.ISO8859-5
ru_RU.KOI8-R
ru_RU.UTF-8
es_ES.ISO8859-1
es_ES.ISO8859-15
es_ES.UTF-8
sv_SE.IS08859-1
sv_SE.ISO8859-15
sv_SE.UTF-8
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Note — Some locales provide limited support, as follows:

®  ar, ar_ EG.UTF-8: GNOME Desktop is not localized. Basic internationalization
support only, with known problem. See “9.5.1 Incomplete Support for Right-to-Left
Languages” on page 61.

®  he, he_IL.UTF-8: GNOME Desktop is not localized. Basic internationalization
support only, with known problem. See “9.5.1 Incomplete Support for Right-to-Left
Languages” on page 61.

= ru_RU.ANSI1251: GNOME session is available, but GNOME Desktop is not
supported.

9.2 Problems That Affect All Locales

The following problems affect all locales:

“9.2.1 Unlocalized Menu Items” on page 48

“9.2.2 Warning Messages to Console” on page 49

9.2.3 Obsolete Topics In Online Help” on page 49

“9.2.4 Multiple Trash Icons” on page 49

“9.2.5 Dialogs and Panels Are Not Localized” on page 49

”9.2.6 Cannot Open a File Created in a Different Locale” on page 50
“9.2.7 Launching gmines Causes a Segmentation Fault” on page 50

9.2.1 Unlocalized Menu Items

Problem Affects all locales.

The following menu items are unlocalized across all locales:
®  Audio Control
B Media Player

Solution This problem will be fixed in a future release.
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9.2.2 Warning Messages to Console

Problem

Solution

Bug ID 4818711, affects all locales.

When you launch GNOME applications from a terminal, you might
occasionally see warning messages in the terminal window.

These warnings do not appear if you launch applications from the
desktop environment menus. These warnings do not affect the
functionality of the application.

This bug will be fixed in a future release of the GNOME Desktop.

9.2.3 Obsolete Topics In Online Help

Problem

Solution

Affects all locales.

Obsolete applications such as gweather and Stock Ticker are
included in online Help.

Ignore Help for obsolete applications.

9.2.4 Multiple Trash Icons

Problem

Solution

Affects all locales.

When you switch languages using dtlogin, and you log in remotely,
multiple Trash icons are shown on the desktop.

Perform the following steps:

®  Open a terminal.

B Change to the . gnome-desktop directory:
cd .gnome-desktop

B Remove unnecessary Trash files.

9.2.5 Dialogs and Panels Are Not Localized

Problem

Affects all locales.

A number of applications display unlocalized dialogs and panels.
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Solution This problem will be fixed in a future release of the GNOME
Desktop.

9.2.6 Cannot Open a File Created in a Different

Locale
Problem Bug ID 4824884, affects all locales.

Nautilus may not open a file that was created in a different locale.
Solution Log in to the locale in which the file was created, then open the file.

9.2.7 Launching gmines Causes a Segmentation
Fault

Problem Affects the gmines game in all locales.

If you install a language package, then gmines causes a
segmentation fault the next time you try to launch the game.

Solution Remove the following file to stop the game from freezing:
/usr/share/locale/ [your-locale] /LC_MESSAGES/gnome-
games . mo.

This action also removes the localization support for all games.

This problem will be fixed in a future release.

9.3 Problems That Affect European
Locales

The following problems affect European locales:

“9.3.1 OpenWindows Login Option Is Missing” on page 51

“9.3.2 Start Menu Is Not Localized” on page 51

“9.3.4 Keyboard Shortcut Does Not Change Input Method Window” on page 52
“9.3.5 Poor Font Quality in Terminal” on page 52

“9.3.6 No Support for CP1251 and ANSI1251 Encoding” on page 52

“9.3.7 Rasterization Problems in Russian Locale” on page 53
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m  “9.3.8 Help Appears Only in English” on page 54
m  “9.3.8 Help Appears Only in English” on page 54

9.3.1 OpenWindows Login Option Is Missing

Problem

Solution

Affects all European locales in the Solaris 8 operating environment.
This is not a problem for the Solaris 9 operatinig environment.

When you install the GNOME 2.0 Desktop you might notice that
OpenWindows is no longer present as a session option in the login
screen.

Perform the following steps to restore the OpenWindows option to
the login screen:
1. Login as root.
2. Run the following command:
cp /usr/dt/config/C/Xresources.d/Xresources.ow
/usr/dt/config/locale/Xresources.d/Xresources.ow

Where locale corresponds to the locale for which you wish to restore
the OpenWindows login option.

9.3.2 Start Menu Is Not Localized

Problem

Solution

Affects the pt_BR.ISO8859-1 locale.

The Start menu is not localized.

This problem will be fixed in a future release.

9.3.3 Characters Are Displayed Incorrectly in the
XScreenSaver Properties Dialog

Problem

Solution

Affects the pt_BR.ISO8859-1 and pt_BR.UTF-8 locales.

In the XScreenSaver Properties dialog, localization characters are
missing, In the pt_BR.UTF-8 locale incorrect characters are
displayed, for example Cryllic characters.

This problem will be fixed in a future release.
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9.3.4 Keyboard Shortcut Does Not Change Input
Method Window

Problem Affects Russian locales.

The keyboard shortcut Ctrl+Spacebar to select and change the input
method window does not work on the x86 architecture edition of
the Solaris operating environment.

Solution Use the mouse to select and change the input method window.

9.3.5 Poor Font Quality in Terminal

Problem Affects Russian locales.
The font quality is low for the Terminal application.

Solution Perform the following steps:
1. Open a terminal, then choose Edit — Profiles.
2. Click on the Edit icon.
3. In the General tabbed section, deselect the check box Use the
same font as other applications.
4. Click on the font selection bar.
5. Choose a suitable font from the Choose a terminal font dialog.

9.3.6 No Support for CP1251 and ANSI1251
Encoding

Problem Affects Russian locales.

The pango X11 shaper in this release of the GNOME Desktop does
not support CP1251 encoding. As a result, CP1251 or ANSI1251
encoded characters are displayed as zero-width or blank characters.

52 GNOME 2.0 Desktop for the Solaris Operating Environment Troubleshooting Guide * April 2004



Solution

Use the following locales, which are supported by the pango X11
shaper, until CP1251 support is available:

®  ru_RUKOI8-R

B ru_RU.ISO8859-5

®  ru_RU.UTF-8

You can use iconv conversion tables to re-encode CP1251 and
ANSI1251 files. To encode a CP1251 or ANSI1251 file into a UTF-8
encoded file, in a terminal run the following command:

/usr/bin/iconv -f CP1251 -t UTF-8 CP1251 filename >
UTF-8 filename. (man iconv)

9.3.7 Rasterization Problems in Russian Locale

Problem

Solution

Affects the ru_RU.KOI8-R locale.

In the Solaris 8 operating environment, x86 architecture edition, you
might experience rasterization problems regarding the following

Russian glyphs:
= 00F1

®m  00FF

m 00DC

This problem affects both the Common Desktop Environment
(CDE) and the GNOME Desktop.

You need to select specific fonts for use within the GNOME

Desktop. Perform the following steps:

B Open a terminal and run the following command:
gnome-font-properties

®  (Click on the Desktop font button in the Font Preferences
dialog.

®  In the Pick a Font dialog, specify a font from the following list:
®  application: medium, medium italic, bold, bold italic
B arial: italic, bold, bold-italic

courier: italic, bold italic

fixed: medium

interface system: medium

monospace: normal

sans: italic, bold italic

times: italic, bold italic

This problem will be fixed in a future release.
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9.3.8 Help Appears Only in English

Problem Bug id 4921134, affects the following locales:
fr_ BE.UTF-8
es_AR.ISO8859-1
es_BO.ISO8859-1
es_CL.ISO8859-1
es_CO.ISO8859-1
es_CR.ISO8859-1
es_EC.ISO8859-1
es_GT.ISO8859-1
es_MX.ISO8859-1
es_NILISO8859-1
es_PA.ISO8859-1
es_PE.ISO8859-1
es_PY.ISO8859-1
es_SV.ISO8859-1
es_UY.ISO8859-1
es_VE.ISO8859-1

Solution Perform the following actions to resolve this issue:
B su passward

cd /usr/share/locale

1n -s parent locale target locale

Log out of your session.

Log in again.

Applications should now appear in the target locale.

9.4 Problems That Affect Asian Locales

The following problems affect Asian locales:

“9.4.1 Default Desktop Font Is Too Small Or Blank” on page 55

“9.4.2 Special Fonts Are Missing in Chinese Locales” on page 55

“9.4.3 GNOME Ghostscript Display” on page 56

“9.4.4 Different Date Format in the Solaris Operating Environment” on page 57
“9.4.5 Character Display Problem in GTK2+ Applications” on page 58

“9.4.6 Printing Out From gedit in the Solaris 8 Operating Environment” on page 58
“9.4.7 Cannot Print Japanese Characters With Default Font in gedit” on page 58
“9.4.8 Cannot Open ISO-2022-JP Encoded File” on page 59

“9.4.9 Localized Characters Do Not Display in gedit” on page 59

“9.4.10 Character Display Problem in Terminal” on page 59

“9.4.11 Core Dump When Copy or Link to File” on page 60
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® “9.412 Input Method Window Repeatedly Flushed” on page 60
®m  “9.4.13 Japanese Locale Core Dump” on page 60
®m “9.4.714 GTK2+ Applications Freeze” on page 61

9.4.1 Default Desktop Font Is Too Small Or Blank

Problem For example: bug ID 4805328, affects some locales, including
Chinese locales.

Currently, you cannot set the default font for the GNOME Desktop
for each locale. As a result, particularly if you are switching
between locales, you might find that the default desktop font is
either too small or is rendered blank.

Solution To change the default desktop font, perform the following steps:
B Open a terminal and run the following command:
gnome-font-properties
B Use the Font Preferences dialog to change font size to
appropriate values. For example, in Chinese locales, you can
set both Application font and Desktop font to Sans 13.

9.4.2 Special Fonts Are Missing in Chinese Locales

Problem Bug ID 4821955, affects Traditional Chinese locales.

You cannot see the characters displayed with some special fonts
such as bold fonts. As a result, some characters in the Yelp window
appear to be missing.
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Solution You must change the pangox.alias file in
/etc/{zh TW.EUC,zh TW.BIG5,zh TW.UTF-
8,zh HK.BIGSHK, zh HK.UTF-8}. Perform the following steps:

1.
2.

Log in as root.

Change to the directory where thepangox.alias file is located
for your locale. For example, for the zh_TW.BIGS5 locale, run the
following command:

cd /etc/pango/zh TW.BIGS

Run the following command:

cat pangox.alias | tr [A-Z] [a-z] > /tmp/pango
Run the following command:

mv /tmp/pango pangox.alias

If the directory /etc/pango/sparcv9/pango is on your
system, change the pangox.alias files. in the locale
subdirectories in that directory, in the same way as for
/etc/pango.

9.4.3 GNOME Ghostscript Display

Problem Affects Asian and Japanese locales.

Characters with the Japanese Postscript font name are garbled
when displayed in GNOME Ghostscript.
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Solution

Perform the following steps:

1.

2.
3.
4

Log in as root.

Run the following command: ed /

Run the following command: mkdir /Resource
Depending on the locale, run one of the following commands:
Simplified Chinese

1n -s
/usr/openwin/lib/locale/zh/X11/Resource/CMap
/Resource/CMap

Traditional Chinese

1n -s

/usr/openwin/lib/locale/zh TW/X11l/Resource/CMap
/Resource/CMap

Japanese

1n -s
/usr/openwin/lib/locale/ja/X11/Resource/CMap
/Resource/CMap

Korean

1n -s
/usr/openwin/lib/locale/ko/X11/Resource/CMap
/Resource/CMap

9.4.4 Different Date Format in the Solaris Operating

Environment

Problem

Solution

Affects Japanese locales.

The date format is different in the Solaris operating environment.
There is no ’(" and ’)’ on the weekday format in the following
locales:

Solaris 8 operating environment: ja_JP.UTF-8
Solaris 9 operating environment: ja_JP.eucJP, ja_JP.UTF-8

Not applicable.
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9.4.5 Character Display Problem in GTK2+
Applications

Problem Bug ID 4785550, affects the gedit application and other GTK2+
applications in Japanese locales.

Part of the IBM/NEC extended character and special characters are
not displayed.

Solution Known limitation.

9.4.6 Printing Out From gedit in the Solaris 8
Operating Environment

Problem Affects Japanese locales.

You can preview JISX0212 in the gedit application, but you cannot
print out JISX0212.

Solution Solaris 8 operating environment: Known limitation.

Solaris 9 operating environment: Perform the following steps:
®  Open the gedit application.
B Choose Edit — Preferences.
B Select Fonts from the Print category, in the Categories panel.
B For each print item, specify either of the following fonts:
®  HG-GothicB-Sun
®  HG-MinchoL-Sun

9.4.7 Cannot Print Japanese Characters With
Default Font in gedit

Problem Bug 4861491, affects Japanese locales.

When you use the default printer font in the gedit application,
Japanese characters are not displayed in Print Preview and are not
printed by printers.
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Solution

Perform the following steps:

B Open the gedit application.

B Choose Edit — Preferences.

®  Select Fonts from the Print category, in the Categories panel.
®  For each print item, specify the HG-GothicB-Sun font.

9.4.8 Cannot Open [ISO-2022-]JP Encoded File

Problem

Solution

Bug ID 4826184, affects Japanese locales.
You cannot open ISO-2022-JP encoded files in the gedit application.

This problem will be fixed in a future release.

9.4.9 Localized Characters Do Not Display in gedit

Problem

Solution

For example: bug ID 4785550, affects Japanese locales.

Japanese characters do not display in the gedit application, when
you select Courier as the default font.

Perform the following steps:

B Open the gedit application.

B Choose Edit — Preferences.

B Select Font & Colors in the Categories panel.
®  Select the option Use default theme font.

This solution does not fix the problem that IBC/NEC extended
character and special characters are not displayed in the Solaris 8
operating environment.

9.4.10 Character Display Problem in Terminal

Problem

Affects Japanese locales.

In the Terminal application Preferences dialog, IBM/NEC extended
character and special characters are not displayed when you select
the option Use the same font as other applications.
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Solution Perform the following steps:
®  Open a terminal.
B Choose Edit — Current Profiles.
®  In the Editing Profiles dialog, deselect the option Use the same
font as other applications.
B Specify the font to be interface user.

9.4.11 Core Dump When Copy or Link to File

Problem Bug ID 4824884, affects Japanese locales.

A core dump sometimes occurs when you use Nautilus to copy or
link to a file that was created in a different locale.

Solution Log in to the locale in which the file was created, then copy the file
or create a link to the file.

9.4.12 Input Method Window Repeatedly Flushed

Problem Bug ID 4781611, affects the ja_JP.UTF-8 locale.

When there are multiple input contexts on the same top-level
application window, the input method window is repeatedly
flushed.

Solution This problem will be fixed in a future release.

9.4.13 Japanese Locale Core Dump

Problem Bug ID 4808468, affects the ja_JP.UTF-8 locale.

An application core dump occurs when you do the following:
1. Choose Unicode List = HIRAGANA from the IM status.
2. Close the application window.

Solution This problem will be fixed in a future release.
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9.4.14 GTK2+ Applications Freeze

Problem

Solution

Bug ID 4820426, affects the ja_JP.UTF-8 locale.

GTK2+ applications freeze when you do the following:
1. Open a Lookup Choice window.
2. Press and hold the space key.

This problem will be fixed in a future release.

9.5 Problems That Affect Complex-Text

Locales

The following problems affect complex—text locales:

m  “9.5.1 Incomplete Support for Right-to-Left Languages” on page 61

9.5.1 Incomplete Support for Right-to-Left

Languages

Problem

Solution

Solaris 8 Operating
Environment:

Solaris 9 Operating
Environment:

Affects Arabic and Hebrew.

Only partial support is available in the GNOME Desktop for
right-to-left languages. Full support for right-to-left language

printing and GUI widget mirroring is currently under development

in the GNOME Desktop.

Arabic and Hebrew text input is supported in the GNOME 2.0
globalization release, with the exception of the Terminal

application. If you have not installed any other language pack, and

you want text input support, then install the following patches:

SPARC Architecture Edition x86 Architecture Edition
114485-01 114486-01
114274-02 114275-02
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Index

A
ANSI1251 encoding, no support for, 52-53
applets, reduce for performance, 38
application freeze, Japanese locales, 61
applications

obsolete, 49

restoring incorrectly, 20
Arabic, partial support for, 61
audio CDs, no sound from, 36

B

background, adjusting for performance, 38

C
CDE applications, improving performance
of, 40
character display
GTK2+ applications, 58
in terminal, 59-60
Chinese
small fonts, 55
special fonts missing, 55-56
core dump
Japanese locale, 60
CP1251 encoding, no support for, 52-53

D

date format, 57-58

defunct applications, in Help, 49
desktop background, no image, 16
dialogs, unlocalized, 49-50

display, multihead, 33
dynamically-set title, Terminal, 29-30

E

error message
failed installation, 12
startup, 16

error messages, general, 25

error messages, missing files, 16

F
file, cannot open, 50

fonts too small, various locales, 55
further information, 23-24

G

geonf, information about, 27
gedit

localized characters do not display, 59

printing problem in Solaris 8 OE, 58
Gedit, restore problem with, 20, 38
general startup problems, 16-17



gmines, freeze, 50
GNOME 1.4 Desktop, uninstalling, 12
GNOME 2.0 Desktop, uninstalling, 12-13
GNOME Desktop menu item, missing from
login screen, 15
GNOME Ghostscript, displaying Japanese
files, 56-57
GTK2+
application freeze, 61
character display, 58

H
Hebrew, partial support for, 61

|
icons, not displaying, 16
input method window
flushing repeatedly, 60
unable to change with keyboard shortcut, 52
installation log, location, 11-12
installing, without the Installer, 13
ISO-2022-JP encoded files, do not open in
gedit, 59

J

Japanese

application freeze, 61

character display in terminal, 59-60

characters do not display in gedit, 59

core dump, 60

date format, 57-58

displaying files in GNOME
Ghostscript, 56-57

opening ISO-2022-JP files in gedit, 59

window flushing, 60

K
keyboard, no response, 41-42

L

locales, localized, 45
localization
all locales, 48
Asian locales, 54
complex—text locales, 61
European locales, 50
log in, applications with restore problems, 20
logging out, sans panel, 19-20
login process, hanging, 16
login screen, GNOME Desktop menu item
missing, 15

M

Main Menu, icon incorrect, 16

MainSoft, setting MWWM for, 20

mediaLib libraries, installing for
performance, 39

menu items, unlocalized, 48-49

Metacity, crashes, 19

mouse, three-button configuration, 34-36

mouse keys, numeric key 9, 43

multihead display, 33

MWWM environment variable, setting for
MainSoft, 20

N

Nautilus
adjusting for performance, 37
crashes or freezes, 26
nautilus, no viewer, 25
Nautilus
slows the system, 26
Netscape 4.x, display problems, 24-25
numeric keypad, no response, 42

o)

OpenWindows, login option missing, 51
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P

panels, unlocalized, 49-50
panels, not appearing, 16
panels, not responding, 16

R

rasterization, Russian glyphs, 53-54
removable media manager, 28
Russian
cannot change input method window, 52
no support for CP1251/ ANSI1251
encoding, 52-53
poor font quality in terminal, 52
rasterization of glyphs, 53-54

S

screensaver, does not display, 28

screensavers, conflicts with, 27

ScrollKeeper, fails after installation, 13-14

slow keys, beep when rejected option, 43

sound events, not working, 34

special fonts missing, Chinese locales, 55-56

Start menu, unlocalized, 51

startup problems, general, 16-17

Sun Ray server, running GNOME Desktop
on, 36

swing, problems with, 21

system, continuous beeps, 42-43

T

Terminal, dynamically-set title options do not
work, 29-30

terminal, poor font quality, 52

Terminal, restore problem with, 20, 38

terminals, adjusting for performance, 39

tif files, crash panels, 26-27

trash icons, multiple, 49

U
uninstalling
GNOME 1.4 Desktop, 12
GNOME 2.0 Desktop, 12-13
unlocalized menu items, 48-49

\)
version, of GNOME Desktop, 24

w

warning messages, console, 49

window border theme, adjusting for
performance, 38

window manager, crashes, 19

windows, unexpected behavior, 20-21

wireframe move mode, enabling for
performance, 39
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